
Organize365

User guide



 

 

Table of Contents
Organize365....................................................................................5
General Information....................................................................... 6
Introduction................................................................................. 7
How to contact us........................................................................ 9
How to purchase........................................................................ 10
License Agreement..................................................................... 11
Privacy Policy............................................................................. 13
Version History...........................................................................14

Getting Started............................................................................ 15
Installing Organize365.................................................................16
Registering Organize365..............................................................17
Start Here!................................................................................ 18
Staying up to date......................................................................19

Calendar......................................................................................20
The Calendar Toolbar.................................................................. 22
The InfoBox............................................................................... 23
My Pictures................................................................................ 25
Keyboard Shortcuts.....................................................................26
How do I................................................................................... 28
Access my calendar...................................................................29
Create an appointment..............................................................30
Create a task........................................................................... 31
Delete an appointment / task..................................................... 32
Move an item to another date.................................................... 33
Move an item to another time.................................................... 34
Edit an appointment / task.........................................................35
Mark an item as "Completed".....................................................36
Use Recurring Items..................................................................37
Print a calendar........................................................................ 39
Search my calendars.................................................................41
Share my calendars.................................................................. 42
Monitor who has accessed my calendars...................................... 43
Set up a meeting......................................................................44
Use Web-Feeds.........................................................................46

Address Book...............................................................................47
The Address Book Toolbar........................................................... 49



 

 

Keyboard Shortcuts.....................................................................50
How do I................................................................................... 51
Access the Address Book........................................................... 52
Add a new address................................................................... 53
Edit an address........................................................................ 54
Delete an address.....................................................................55
Use Contact Groups.................................................................. 56
Print Addresses.........................................................................57
Import / Export Addresses......................................................... 59
Search my contacts...................................................................60

Email.......................................................................................... 61
The Email Toolbar.......................................................................63
The Email-Views Tree..................................................................64
Junk Email.................................................................................65
Keyboard Shortcuts.....................................................................66
How do I................................................................................... 67
Set up an email account............................................................68
Receive email........................................................................... 69

The Email Editor.........................................................................70
Keyboard Shortcuts...................................................................72
How do I................................................................................. 73
Send an email........................................................................ 74
Send an attachment................................................................ 75
Insert a picture.......................................................................76
Send a newsletter................................................................... 77

Newsgroups............................................................................... 80
How do I................................................................................. 81
Set up a newsgroup account.................................................... 82

Data Vault................................................................................... 85
Keyboard Shortcuts.....................................................................87
How do I................................................................................... 88
Print data.................................................................................89

Desktop Notes............................................................................. 91
How do I................................................................................... 93
Create a desktop note...............................................................94
Delete a desktop note............................................................... 95
Close a desktop note................................................................ 96



 

 

Enter text into a desktop note....................................................97
Instant Messaging........................................................................ 98
Keyboard Shortcuts...................................................................100
How do I................................................................................. 101
Chat with another user............................................................ 102

Miscellaneous............................................................................. 103
Using the Report Previewer........................................................104
Sharing your data with other users............................................. 105
Logging in / out........................................................................109

Program Options.........................................................................110
General....................................................................................111
Interface.................................................................................. 112
Projects................................................................................... 113
Email.......................................................................................114
Calendar.................................................................................. 115
Calendar Labels........................................................................ 116
Calendar Reminders.................................................................. 117
My Pictures.............................................................................. 118
Data Sharing............................................................................119
Notification...............................................................................120
Backup.................................................................................... 121
Hotkeys................................................................................... 122
Program Logs........................................................................... 123
System Info............................................................................. 124

FAQs......................................................................................... 125
The System Tray Icon............................................................... 126
Context-sensitive help............................................................... 127
Registration code failing.............................................................128

Addendums................................................................................129
Using Organize365 in other languages.........................................130



 

 

Organize365
 

 
 



 

 

General Information
 

 
 



 

 

Introduction
 
 

 
 
Organize365 is a Personal Information Manager, intended for use in everyday information
and communication tasks. These tasks include:
 

• Managing your Appointments
• Managing your Tasks
• Managing your Email
• Managing your Address Book

 
Organize365 also includes several other useful tools, including Instant Messaging
(sending messages to other users on your computer network), Desktop Notes ("Sticky
Notes"), and a Data Vault which you can use to store data (such as passwords, recipes,
directions, ideas, etc).
 
This software was developed to create a tool that would simplify life, and free up time.
Finding a balance between creating an easy to use product, while retaining powerful
functionality to offer all the necessary features was the challenge. Strategy realized
that a tool like Organize365 should reduce daily stress, not add to it, which is why a lot
of time was spent in making sure that features such as backing up of data, sharing of
Calendars and Addresses with other users, and so on, are all built-in, robust and easy to
configure.
 



 

 

If you are using Organize365 for the first time, it is recommended that you start off by
reading the section titled Getting Started.
 
Thank you for using Organize365 - we hope you will benefit from it and enjoy using it.
 
 



 

 

How to contact us
 
 
Should you wish to contact us, our contact details are provided below. If you need
technical assistance you may wish to refer to the Frequently Asked Questions section in
this document, which contains a list of commonly asked questions.
 
 
 
www.strategyonline.co.za/organize365
 
 

http://www.strategyonline.co.za/organize365


 

 

How to purchase
 
 
You can purchase Organize365 on our website at www.strategyonline.co.za/organize365.
 
If you would prefer to purchase Organize365 using a direct transfer, or if you have any
questions regarding licensing, please feel free to contact us.
 
 

http://www.strategyonline.co.za/organize365


 

 

License Agreement
 
 
IMPORTANT - PLEASE READ CAREFULLY
 
This End-User License Agreement is a legal agreement between you (either an individual
or a single entity) and Heldersoft CC trading as StrategyOnline.co.za, for the software
built by StrategyOnline called "Organize365", which includes computer software and may
include associated media, printed materials, and "online" or electronic documentation. By
installing, copying, or otherwise using this software you agree to be bound by the terms
of this End-User License Agreement.
 
SOFTWARE PRODUCT LICENSE
 
The software is protected by copyright laws and international copyright treaties, as well
as other intellectual property laws and treaties. The software is licensed, not sold. You
may not rent, lease, sell, or lend this software to anyone else.
 
GRANT OF LICENSE
 
This program version may be installed on a maximum of two computers, as long as it is
ONLY used by the same licensee on either computer: i.e. one installation at home and
one installation at the office and used only by the licensee. The simultaneous use of this
software by multiple personnel requires additional licenses. Use of this software over
an internal network requires separate licenses for each user. The licensee shall not use,
copy, rent, lease, sell, modify, decompile, disassemble, reverse engineer, or transfer the
licensed software except as provided in this agreement. Any violations to the points laid
out in this license agreement may result in severe civil and criminal penalties, and will be
prosecuted to the maximum extent possible under the law.
 
LIABILITY
 
We try to keep our software as bug free as possible. However, we cannot guarantee this.
Any liability for damage of any sort is hereby denied. In no event shall Heldersoft, Gary
James, StrategyOnline, StrategyOnline.co.za, employees of Heldersoft CC, employees
of Gary James, employees of StrategyOnline.co.za or Dealers of this product be liable
for any special, incidental, indirect, or consequential damages whatsoever (including,
without limitation, damages for loss of business profits, business interruption, loss of
business information, or any other pecuniary loss) arising out of the use of or inability to
use this software.
 
Thank you for your understanding and cooperation.
 



 

 

 



 

 

Privacy Policy
 
 
We will not give out any information that you provide us with to anyone. Organize365
does not send us (or anyone else) any information about you, your computer, your
system, or anything else along those lines.
 
If you have any questions at all regarding our software please contact us.
 
 



 

 

Version History
 
 
Version 9.00 (-)
 

• FEATURE: New documentation.
• DEPRECATED: Removed the Project Management screen.
• DEPRECATED: Removed all license expiry checks.
• DEPRECATED: Removed the "Check PC Time" tool.
• DEPRECATED: Removed the "Countdown Timer" tool.

 
 



 

 

Getting Started
 

 
 
 



 

 

Installing Organize365
 
 
To install Organize365 from our website...
 
Go to www.strategyonline.co.za/organize365, click on "Downloads", and follow the
instructions on that page to download the latest installer (EXE).
 
Run the installer EXE that you downloaded in step 1, and simply follow the installer's
instructions.
 
 
To install Organize365 from a CD-ROM...
 
Insert the Organize365 CD into your CD-ROM drive.
 
The installer program will launch automatically. Simply follow the installer's instructions.
 
 
If you want to uninstall Organize365...
 
Click the Windows "Start" button, then select "Programs", then select "Organize365",
then select "Uninstall or Repair", and then click on "Uninstall Organize365".
 
 

http://www.strategyonline.co.za/organize365


 

 

Registering Organize365
 
 
To enter a registration code into Organize365, simply right-click on the System Tray
Icon, select "Help", and then click on "Register Organize365". A screen will then appear
where you can enter the registration code. Please use the Context-Sensitive Help on that
screen should you require further assistance.
 
If your registration code does not seem to work, please click here for help.
 
 



 

 

Start Here!
 
 
Once you have installed Organize365 (for more information on how to install
Organize365 please click here), you will see that a new icon appears in your System
Tray, as follows:
 

 
This icon is called the Organize365 "System Tray Icon". If you right-click on this new
icon, a menu will appear, from where you can open your Calendar, Address Book, and so
on.
 
The best way to learn how to use Organize365 is to simply explore the software. Once
you have spent a couple of minutes exploring come back to this documentation and skim
through it. That will give you a good overall feel for how the software and documentation
work.
 
Every screen has a button at the bottom labeled "Help". If you click the "Help" button
this document will open to the relevant section. Most screens also have Context-
Sensitive Help which explains what the various controls and fields do.
 
Please feel free to contact us if you have any questions or need any assistance.
 
 



 

 

Staying up to date
 
 
You can download the latest version of Organize365 by visiting our website at
www.strategyonline.co.za/organize365.
 
You can also get Organize365 to check for new updates itself by right-clicking on the
System Tray Icon, and choosing "Check for Updates"...
 
 

 
 
This is much easier than manually downloading and installing updates from the the
website, and Organize365 will only download the components it needs, so updates won't
take as long to download!
 
 

http://www.strategyonline.co.za/organize365


 

 

Calendar
 
 
To open the Organize365 Calendar, simply right-click on the Organize365 System Tray
Icon, and choose "Calendar" from the menu that will appear. Below is a picture showing
the Calendar, with the various parts of the screen outlined beneath it.
 
 

 
 
Menubar
 
The "Menubar" contains your menus, which in turn provide you with numerous tools and
options.
 
 
Toolbar
 
While all the features offered to you via the Menubar are useful, some features (such as
"Jump to Today", "Go to next week" and so on) are also accessible via your Toolbar. This
provides you with a quick way to access features that you will be using frequently. For
more information click here.
 
 
MiniCal
 
The "MiniCal" is short for "Mini Calendar". It is essentially a small calendar (hence the
name) which you can use to "control" or "navigate" the larger Calendar. Simply click a
date on the MiniCal and the main Calendar will jump to that date. You can also use the
directional arrows on the MiniCal to jump forward or backward by a month.
 
 



 

 

Appointments
 
The "Appointments" section of the Calendar displays your appointments.
 
 
InfoBox
 
The "InfoBox" (short for "Information Box") is a powerful tool which provides you
with a vast amount of information that cannot be displayed on the Calendar. For more
information please click here.
 
 
Tasks
 
The "Tasks" section of the Calendar displays your tasks. Think of tasks as your "To Do"
list.
 
 



 

 

The Calendar Toolbar
 
 
The toolbar on your Calendar contains some of the basic functions that you will use
frequently when using your Calendar. Below we outline some of this functionality.
 

 
This part of the toolbar (shown above) can be used to adjust the dates displayed in the
calendar, by going backward or forward by a day, a week or a month. You can also use
these controls to jump to a date which you select from a popup calendar.
 

 
This part of the toolbar (shown above) can be used to adjust the Calendar "View".
By that we mean that you can either view a single day, or 5 consecutive days, or 7
consecutive days, or 14 consecutive days, or a full month.
 

 
This part of the toolbar (shown above) can be used to change your zoom (so that the
calendar items appear larger or smaller), or to hide / unhide the Tasks section of the
Calendar, or the MiniCal and InfoBox sections.
 
 



 

 

The InfoBox
 
 
Over time users have sent us requests along the lines of "When I'm using my calendar
I would love to be able to see...". Some of these requests we have built directly into
the Calendar (such as birthdays and anniversaries from the Address Book), which other
requests we decided to add, but not directly into the calendar itself - instead we came
up with a control which we added next to the calendar, and called the 'InfoBox' (short for
'Information Box'). At the top of your InfoBox are five icons, as follows...
 

 
You can click on these icons to select what sort of information you want to view in the
InfoBox. From left to right, these icons are 'View Calendars', 'View Address Book', 'View
Other Users', 'View RSS Feeds', and 'InfoBox Options'. These are discussed separately
below.
 
1. Calendars
 
Clicking this button will show you a list of Calendars, you can then tick which Calendars
you want to view. By default you will only have 'one calendar' in Organize365, in which
all your Appointments and Tasks will be kept. If you are finding that your Calendar is
becoming cluttered you may want to create multiple calendars for yourself, such as
'Work', 'Private', 'Band', or whatever. You can them assign Tasks and Appointments to
calendars, so all your work-related Appointments and Tasks will be filed in your 'Work'
calendar, and so forth. Once you start doing that, you can then easily view only your
Work calendar, or you view multiple calendars at the same time. This can make it much
easier to compartmentalize your various Tasks and Appointments, and helps to keep
your calendar uncluttered. To create multiple calendars for yourself, simply right-click
on the InfoBox (first click on the 'Calendars' button at the top of the InfoBox), and
then select 'Configure My Calendars'. A window will appear where you can create new
calendars, click the 'Help' button on that window for further assistance.
 
The Calendars section not only shows your calendars, but it will also list other users who
have given you permission to view their calendars! See the section titled Data-Sharing
Overview for more information.
 
2. Address Book
 



 

 

If you click on the second button above the InfoBox you will see a list of all the people in
your Address Book. You can right-click on the InfoBox control to insert, change or delete
an address. This is simply a quick and convenient way to access your Address Book when
working from your Calendar.
 
3. Other Users
 
The third button above your InfoBox will show a list of all the other Organize365 users
on your network. Right-click on a username will present you with a menu, from where
you can select multiple actions, including 'Chat', which will begin a Chat conversation
with that user.
 
4. RSS Feeds
 
(This section has been removed from Organize365.)
 
4. Options
 
If you click on this button a menu will appear presenting options applicable to whatever
you are currently doing with the InfoBox control.
 
 



 

 

My Pictures
 
 

 
The "My Pictures" area in your Calendar will display any pictures (JPG) located in the
your "C:\Program Files\Organize365\My Pictures" directory. It can also display quotes
(text) that you can enter from the Program Options screen. You can select an alternate
directory, and you can adjust various settings from the Program Options screen, if you so
choose.
 
 



 

 

Keyboard Shortcuts
 
 
Sometimes it is simpler and faster to use your keyboard than your mouse.
 
Below are a number of tasks that can be performed by simply pressing a combination of
keys on your keyboard. For instance, if you want to insert a new appointment into your
Calendar, you could do this by clicking the "New Appointment" button on your toolbar, or
by selecting the "File" menu, then selecting "New", and then "Appointment", or you could
simply press "CTRL+SHIFT+A" on your keyboard, as shown in the list below. ("CTRL
+SHIFT+A" simply means that you hold down your "CTRL" key, then hold down your
"SHIFT" key, and then press the "A" key).
 
 



 

 

 
 
 



 

 

How do I...
 
 



 

 

Access my calendar
 
 

• Right-click on the System Tray icon.
• Choose "Calendar".

 
 



 

 

Create an appointment
 
 
Method 1:
 

• In your Calendar, right-click where you want the new appointment to appear.
• Choose "New Appointment" from the menu that will appear.

 
This is the best way to add a new appointment as the appointment date and time will
already be entered for you based on where in your calendar you clicked.
 
Method 2:
 

• In your Calendar, select the "File" menu.
• Select "New".
• Click on "Appointment".

 
Method 3:
 

• In your Calendar, click the "New Appointment" button on the toolbar.
 
 



 

 

Create a task
 
 
Method 1:
 

• In your Calendar, right-click where you want the new task to appear.
• Choose "New Task" from the menu that will appear.

 
This is the best way to add a new task as the task date will already be entered for you
based on where in your calendar you clicked.
 
Method 2:
 

• In your Calendar, select the "File" menu.
• Select "New".
• Click on "Task".

 
Method 3:
 

• In your Calendar, click the "New Task" button on the toolbar
 
 



 

 

Delete an appointment / task
 
 
If the item is part of a recurring series, then you need to click here to see how to delete
it. Otherwise read the section below.
 
Method 1:
 

• Right-click on the appointment / task.
• Select "Delete" from the menu that will appear.

 
Method 2:
 

• Select the appointment / task.
• Press the "Delete" key on the keyboard.

 
 

recurring_items.htm


 

 

Move an item to another date
 
 
If the item is part of a recurring series, then you need to click here to see how to edit it.
Otherwise read the section below.
 
Method 1:
 

• Edit the appointment / task, and then change the date manually (Click here for
help).

 
Method 2:
 

• Move the appointment / task by dragging it from one date to another using your
mouse.

 
Method 3:
 

• Right-click on the appointment / task.
• Select the "Move To" submenu from the menu that will appear.
• Select either "Same time next week" or "Select a Date" depending on what you

want to do.
 
 



 

 

Move an item to another time
 
 
If the item is part of a recurring series, then you need to click here to see how to edit it.
Otherwise read the section below.
 
Method 1:
 

• Edit the appointment / task, and then change the time manually (Click here for
help).

 
Method 2:
 

• Move the appointment / task by dragging it from one time to another using your
mouse.

 
 



 

 

Edit an appointment / task
 
 
If the item is part of a recurring series, then you need to click here to see how to edit it.
Otherwise read the section below.
 
Method 1:
 

• Double-click on the appointment / task.
 
Method 2:
 

• Right-click on the appointment / task.
• Select "Edit" from the menu that will appear.

 
Method 3:
 

• You can also change an appointments start time or end time by simply dragging it
with your mouse.

 
 



 

 

Mark an item as "Completed"
 
 

• Right-click on the appointment / task.
• Select "Mark as Complete" from the menu that will appear.

 
 



 

 

Use Recurring Items
 
 
A recurring item is simply an Appointment or a Task that occurs on a regular basis.
 
For example, if you have the same meeting every Thursday at 5pm, then you have two
options. Either you can insert a new appointment every week on Thursdays at 5pm, or
you can insert one appointment, and then set that appointment to recur every Thursday
at that time. Once you have set the appointment as 'recurring' it will appear every week
at that time.
 
How to create a recurring item
 

1. Open your Calendar
2. Create a new Appointment or Task (Click here for help)
3. Click the "Recurrence..." button on your new Appointment / Task.
4. Use the Context-Sensitive Help on the "Recurrence" screen for more information.

 
How to delete a recurring item
 
To delete a recurring item, simply right-click on the item and choose "Delete". If you
delete a recurring item the all the entries for that item will be delete, not just the one
that you are clicking on.
 
How to edit a recurring item
 
The first thing you need to ask yourself is "What do I want to edit?".
 
A) I want to change something on only ONE item.
 

1. Right-click on the item and choose "Edit".
2. A message will ask you whether you want to edit the occurrence or the series,

choose "occurrence".
3. Change the start time, end time, title, etc, then click "OK".

 
B) I want to change the TIME for ALL items.
 

1. Right-click on the item and choose "Recurrence".
2. Change the start time and / or the end time, then click "OK".

 
C) I want to change the TITLE for ALL items.
 

1. Right-click on the item and choose "Edit".



 

 

2. A message will ask you whether you want to edit the occurrence or the series,
choose "series".

3. Change the title, label, priority, etc, then click "OK".
 
 



 

 

Print a calendar
 
 
With Organize365 you can easily print a range of Calendars, including a Weekly calendar,
a Monthly calendar, and a Yearly Planner. You can also choose whether you want to print
out your Appointments, Tasks, Events, or the Birthdays and Anniversaries from your
Address Book (or any combination of these). Furthermore, you can print to a printer,
you can preview the printout on your screen, or you can even create a PDF! To print a
calendar, simply open your Organize365 Calendar and choose "Print a Calendar..." from
your "File" menu. The screen that will appear is outlined below...
 
Print Style:
 
Select whichever "Style" calendar you want to print.
 
Print Range:
 
Enter the date range that you want to print (from which date, to which date). You can
also use this section to specify whether you want to view Appointments, Tasks, All-Day
Events, or Birthdays / Anniversaries - or any combination of these items.
 
Target:
 
Here you can select from a number of "Targets", including the default printer, or PDF!
 
Other Options:
 
The options displayed here will vary depending on what you selected above in the
"Target" section. If you select to print to a printer, then you will be presented with:
 

• "Preview before printing" - This opens a "Print Preview" screen from where you
can either print the report, or you can cancel.

 
If you select "PDF" as the Target (see above), then you be presented with these options:
 

• "Open the file after we have generated it" - This will cause the PDF to open
(using Adobe Acrobat Reader if it is installed on your computer) after it has been
saved. Adobe Acrobat Reader is a free download (built by Adobe - not by us, we
take no responsibility or credit for how it works) and can be downloaded from
www.adobe.com.

• "Open the folder we are saving into once generated" - This will open the folder
into which the PDF was generated (using Windows Explorer).

http://www.adobe.com/


 

 

• "Filename" - Organize365 will generate the report, and then save it to your hard
drive as a PDF document. Enter the file name for that PDF document here, or use
the lookup button to select a PDF file (which will be overwritten).

 
Once you have selected the options that you want to use, simply press the "Print"
button, or the "Generate" button.
 
 



 

 

Search my calendars
 
 

• Select the Calendar's "Tools" menu.
• Click on "Find".

 
We will be adding more functionality to the Search Tool in the future, and will update
this documentation at that time. For now the screen is self-explanatory, and contains
Context-Sensitive Help which explains what the various fields do. If anything is not clear
please let us know.
 
 



 

 

Share my calendars
 
 
This topic is discussed in detail here.
 
 



 

 

Monitor who has accessed my calendars
 
 
( This section is still being developed and has not yet been documented. )
 
 



 

 

Set up a meeting
 
 
Organize365 makes it easy to set up meetings with other users (assuming they are
also using Organize365). Below are the steps that you would need to take to set up a
meeting using Organize365.
 
Firstly, someone needs to actually take charge of setting up the meeting, and inviting
users to attend it. This person is called the "Organizer". The Organizer simply opens their
Calendar, and creates a new appointment. Once they have created an appointment, they
can then invite other users to attend that appointment. To invite others you simply right-
click on an appointment, and choose "Invite..." from the menu that will appear. A new
window will then open, from where you can select the users that you wish to invite to
attend the meeting. Simply select whoever you want to invite, and click "OK". They will
then be invited to attend.
 
When a user receives an invitation to attend a meeting, that meeting (appointment)
will simply appear in their calendar. It will flash with a red background to indicate that
it is something that needs their attention. You will see that meetings differ from regular
appointments also in that they have a small icon in the upper left corner, as follows:
 
 

 
 
The recipients of meeting requests then simply right-click on those requests, and select
a response from the menu that will appear (shown above). Responses can be either
"Accept invitation", "Decline invitation", or "Request alternate time". If you select
"Accept invitation", the meeting will remain in your calendar, however if you select either
"Decline invitation" or "Request alternate time" the meeting will disappear from your
calendar. Once you have selected a response the Organizer will be notified accordingly.
If you point your mouse at the meeting request a tooltip will appear, which will display
(among other things) the name of the person who sent the invitation.
 
The Organizer (not the recipients) can at any time right-click on the meeting, and select
either "Invite More Users" to invite more users <g>; or he can select "Cancel Meeting" to
cancel the meeting, in which case all meetings requests that other users have received



 

 

will automatically be removed from their calendars (marked as Cancelled, not deleted);
or he can select "View Status" to see who has replied to the invitation, for example:
 
 

 
It's as easy as that! If you have any ideas for how we can improve this functionality
please let us know.
 
PLEASE NOTE: Because Organize365 uses its own peer-to-peer replication engine to
share data across a network (as opposed to a server), any changes that you make to
your own calendar, or any meeting requests that you send out will not appear on other
users calendars immediately. For the shortest possible delay, all users should tick the
"Automatically synchronize every X minutes" checkbox in the "Data Sharing" section on
the "Program Options" screen, and should set Organize365 to automatically synchronize
every 1 minute.
 
 



 

 

Use Web-Feeds
 
 
This feature is no longer available.
 
 



 

 

Address Book
 
 
To open the Organize365 Address Book, simply right-click on the Organize365 System
Tray Icon, and choose "Address Book" from the menu that will appear. Below is a picture
showing the Address Book, with the various parts of the screen outlined beneath it.
 
 

 
 
Toolbar:
 
We will be adding more functionality to the toolbar in future versions. For now it contains
a droplist, which you can use to select which Contact Group you want to view. For more
information on the Toolbar, click here.
 
Contact List:
 
This list displays the addresses in your Address Book. Clicking on a column name ("First
Name", "Last Name" or "Company Name" will resort the list in that order). Use the
"Insert", "Change" and "Delete" buttons below the list to add / edit / delete addresses
from your Address Book.
 
Preview Pane:
 
If you select an address in your Contact List, more comprehensive details for that
address will be displayed in your Preview Pane. You can click or right-click on various
items in the Preview Pane to start an email to the selected person, open their webpage,
etc.
 
More information is available by using the Context-Sensitive Help feature.
 



 

 

 



 

 

The Address Book Toolbar
 
 
At this stage the Toolbar contains a single droplist, which lists any Contact Groups that
you have set up, and can be used to limit the addresses displayed to those that belong
to a certain Contact Group. For more information on Contact Groups click here.
 
 



 

 

Keyboard Shortcuts
 
 
Sometimes it is simpler and faster to use your keyboard than your mouse.
 
Below are a number of tasks that can be performed by simply pressing a combination
of keys on your keyboard. For instance, if you want to create a new Contact, you could
do this by clicking on "New Contact" in the "File" menu, or you could simply press "CTRL
+SHIFT+C" on your keyboard, as shown in the list below. ("CTRL+SHIFT+C" simply
means that you hold down your "CTRL" key, then hold down your "SHIFT" key, and then
press the "C" key).
 
 

 
 



 

 

How do I...
 
 



 

 

Access the Address Book
 
 

• Right-click on the System Tray Icon.
• Click on "Address Book".

 
 



 

 

Add a new address
 
 
Method 1:
 

• Right-click on the Organize365 System Tray Icon.
• Open the Address Book.
• Click the 'Insert' button.

 
Method 2:
 

• From your Calendar, click on the "Address Book" icon at the top of the InfoBox.
• Right-click on the InfoBox and select "Insert an Address".

 
 



 

 

Edit an address
 
 

• Open the Address Book (click here if you need help with that).
• Select the Address you wish to edit.
• Click the 'Change' button.

 
 



 

 

Delete an address
 
 

• Open the Address Book (click here if you need help with that).
• Select the Address you wish to delete.
• Click the "Delete" button.

 
 



 

 

Use Contact Groups
 
 
As you add more and more addresses into your Address Book you may find that it
becomes harder to keep track of addresses. To help alleviate this problem, we have built
a feature called 'Contact Groups', which lets you view only a subset of the addresses in
your Address Book.
 
For example, you could create Contact Groups called 'Family', 'Work Colleagues', 'Band
Members', and so on. You can categorize your addresses according to these groups.
Once this is done, you can either view all the addresses in your Address Book, or you can
view only those addresses that belong to a certain Contact Group ('Band Members' for
example).
 
With Organize365 you can create as many Contact Groups as you like, and you can
assign addresses to as many Contact Groups as you like! In other words one address can
belong to more than one Contact Group.
 
To create new Contact Groups, simply open your Address Book, select the 'Groups'
menu, and then click on 'Edit Groups'. A new screen will appear with buttons labeled
'Insert', 'Change' and 'Delete'. You can use that screen to insert new Contact Groups,
edit (change) Contact Groups, or delete Contact Groups. This screen has Context-
Sensitive Help in case you get stuck.
 
Once you have created Contact Groups, you can then assign your addresses to these
groups. To do this simply edit an address (click here if you don't know how to do that),
then select the 'Groups' section - from here you can simply tick whichever Contact
Groups you want the address to belong to.
 
Once you have created Contact Groups and have assigned your addresses to whichever
groups they belong in, you can then use the 'Group' droplist on your Address Book's
ToolBar to determine whether you view all your addresses, or only those addresses that
belong to a certain Contact Group.
 
 



 

 

Print Addresses
 
 
With Organize365 you can easily print Addresses from your Address Book. You can print
to a printer, you can preview the printout on your screen, or you can even create a PDF!
To print Addresses, simply open your Organize365 Address Book, and choose "Print
Addresses..." from your "File" menu. The screen that will appear is outlined below...
 
Print Style:
 
Select whichever "Style" calendar you want to print. At this time there is only one style
you can choose, called "Table Style". More styles will follow in future versions.
 
Print Range:
 
From this droplist you can either choose to include all the Addresses in your Address
Book (by choosing "Everyone"), or you can select a Group of Addresses.
 
Target:
 
Here you can select from a number of "Targets", including the default printer, or PDF!
 
Other Options:
 
The options displayed here will vary depending on what you selected above in the
"Target" section. If you select to print to a printer, then you will be presented with:
 

• "Preview before printing" - This opens a "Print Preview" screen from where you
can either print the report, or you can cancel.

 
If you select "PDF" as the Target (see above), then you be presented with these options:
 

• "Open the file after we have generated it" - This will cause the PDF to open
(using Adobe Acrobat Reader if it is installed on your computer) after it has been
saved. Adobe Acrobat Reader is a free download (built by Adobe - not by us, we
take no responsibility or credit for how it works) and can be downloaded from
www.adobe.com.

• "Open the folder we are saving into once generated" - This will open the folder
into which the PDF was generated (using Windows Explorer).

• "Filename" - Organize365 will generate the report, and then save it to your hard
drive as a PDF document. Enter the file name for that PDF document here, or use
the lookup button to select a PDF file (which will be overwritten).

 

http://www.adobe.com/


 

 

Once you have selected the options that you want to use, simply press the "Print"
button, or the "Generate" button.
 
 



 

 

Import / Export Addresses
 
 
To export your Address Book to other file formats, simply do the following...
 

• Open the Address Book.
• Select the "File" menu.
• Click on "Import and Export".

 
At this stage you cannot yet import data into Organize365 (that feature is coming soon),
and you can only export data to CSV format (which you can then open using Notepad or
Excel). We will be expanding this feature in the future.
 
 



 

 

Search my contacts
 
 

• Select the "Tools" menu.
• Click on "Find".

 
For more information please see the section in the documentation titled How do I search
my Calendar, which makes use of the same tool.
 
 



 

 

Email
 
 
To open the Organize365 Email client, simply right-click on the Organize365 System Tray
Icon, and choose "Email" from the menu that will appear.
 
The Organize365 email documentation is split into two sections, this section (covering
the email client where you receive and read emails), as well as a section on the Email
Editor, which covers how to create and send emails.
 
Below is a picture showing the Email client, with the various parts of the screen outlined
beneath it. The best way to learn how to use Organize365's email functionality is to take
a look at the section in the documentation titled "How do I" which covers frequently
asked questions.
 
 

 
 
Toolbar:
 
The Toolbar contains buttons that will enable you to quickly create a New Email, Reply
to an email, Forward an email, and Send & Receive. For more information on the toolbar
please click here.
 
Email Views Tree:
 
Unlike some email clients which use email folders, Organize365 uses "Views". This is
explained in more detail here.
 
Email List:
 
Use the Mail Views Tree to determine which emails are listed here, then select an email
here to preview it in the Mail Preview pane.



 

 

 
Preview Pane:
 
The currently selected email (in the Email List above) is displayed in the Preview Pane.
 
 



 

 

The Email Toolbar
 
 
We have deliberately tried to keep the Email Client's toolbar as simple as possible, and
for this reason have only added the following buttons:
 

• "New" - Create a new email message.
• "Reply" - Reply to the currently selected email.
• "Forward" - Forward the currently selected email.
• "Send / Receive" - Download new email messages.

 
 



 

 

The Email-Views Tree
 
 
Most email programs use "Mail Folders", where different emails are stored in different
folders.
 
Organize365 uses a different approach to email. We use "Mail Views", where all your
email is stored in one folder, but you can use "Mail Views" to limit which emails you want
to work with.
 
 

 
 
For example, if you click on "Inbox" in the Email-Views tree, Organize365 will then list
all the emails that you have received. In the "Inbox" View you will notice that there are
subfolders (sub-Views) such as "Known Addresses", "Unknown Addresses", "Read Later",
and "Archives". Clicking on one of these views will display only the emails that match
those criteria. There are also Views called "Outbox", "Sent Items", and "Deleted Items".
 
 



 

 

Junk Email
 
 
Spam is a serious problem. Organize365 has several mechanisms in place to help
alleviate the problem of spam.
 
Firstly, the Email Tree contains a node called "Known Addresses". Anyone who is in your
Address Book is considered to be a "Known Address". By simply clicking on the "Known
Addresses" node you will be able to view all emails which you have received from people
who you know. These are unlikely to be spam, and are usually the most important emails
to respond to.
 
Once you have processed email from your "Known Addresses", you can then click on the
"Unknown Addresses" node. This is where you are likely to find some spam messages.
Any mail in this folder which is not spam should be added to your "Known Addresses" by
simply right-clicking on the email and choosing "Add to Address Book". Once you have
done that, then any emails received from that person in the future will be displayed in
your "Known Addresses" section.
 
If you find any emails in your "Unknown Addresses" section which are spam or junk
emails, you can either delete them, or you can mark them as "Junk". To mark an email
as "Junk", you can either right-click on the email and select "Junk Email", or you can use
the CTRL+J keyboard shortcut.
 
When you mark email as "Junk" it will be moved to your "Junk Email" section.
Organize365 will also then watch for any other emails received from the same address in
the future, and will automatically move them to your "Junk Email" folder for you!
 
By using the techniques described here you will gradually teach Organize365 who your
"Known Addresses" are, and Organize365 will start sorting your email for you into
"Known Addresses", "Unknown Addresses" and "Junk".
 
 



 

 

Keyboard Shortcuts
 
 
Sometimes it is simpler and faster to use your keyboard than your mouse.
 
Below are a number of tasks that can be performed by simply pressing a combination
of keys on your keyboard. For instance, if you want to create a new email message, you
could do this by clicking the "New Email" button on your toolbar, or you could simply
press "CTRL+N" on your keyboard, as shown in the list below. ("CTRL+N" simply means
that you hold down your "CTRL" key, then press the "N" key).
 
 

 
 



 

 

How do I...
 
 



 

 

Set up an email account
 
 
Before you can use Organize365 to send and receive email you will need to set up
an email account. Typically your service provider will provide you with information
about your email account, such as a username and password. You need to enter that
information into Organize365 by following these steps:
 

• Open the Email screen.
• Click on "Email Accounts" in the "Tools" menu.
• Click the "Insert" button to add a new email account.

 
Please use this screen's Context-Sensitive Help feature to find out more about what the
various settings and options do. If anything is not clear please let us know.
 
 



 

 

Receive email
 
 

• Open the Email screen.
• Click on the "Send / Receive" button in the toolbar.

 
Once you click the "Send / Receive" button you will be able to monitor the progress of
emails being downloaded by looking at the information displayed in your status bar.
 
 



 

 

The Email Editor
 
 
When you create a new email, or reply to or forward an email that you have received,
you will need to use the Email Editor screen.
 
 

 
Toolbar:
 
The Toolbar contains the a number of buttons. Simply point your mouse at any of the
buttons and a tooltip will appear showing you what that particular button does.
 
To:
 
Enter the email address that you want to send your email to here. You can enter a single
email address, or you can enter multiple email addresses as long as you separate the
addresses with a semi-colon. You can also click on the "To" button to select addresses
from your Address Book.
 
CC:
 
If you want to CC the email you can enter those addresses here. You can enter a single
email address, or you can enter multiple email addresses as long as you separate the
addresses with a semi-colon. You can also click on the "CC" button to select addresses
from your Address Book.
 
BCC:
 
If you want to BCC the email you can enter those addresses here. You can enter a single
email address, or you can enter multiple email addresses as long as you separate the
addresses with a semi-colon. You can also click on the "BCC" button to select addresses
from your Address Book.



 

 

 
Subject:
 
Enter the email subject here.
 
Email Body:
 
Compose your email here.
 
 



 

 

Keyboard Shortcuts
 
 
Sometimes it is simpler and faster to use your keyboard than your mouse.
 
Below are a number of tasks that can be performed by simply pressing a combination of
keys on your keyboard. For instance, if you want to send an email, you could do this by
clicking the "Send" button on your toolbar, or you could simply press "ALT+S" on your
keyboard, as shown in the list below. ("ALT+S" simply means that you hold down your
"ALT" key, then press the "S" key).
 
 

 
 



 

 

How do I...
 
 



 

 

Send an email
 
 
To create and send a basic email, follow these steps:
 
From the Email screen, click on the "File" menu, then click on "New Mail Message". This
will cause the Email Editor screen to appear.
 
In the "To" field, enter the person's email address. This address is where your email will
be sent to. For example, bob@aol.com.
 
Enter a title for your email in the "Subject" field. This can be something like "Hi Bob",
"Feel like a fishing trip", or something like that.
 
Type your email message in the large field immediately below the "Subject" field.
 
When you are ready to send the email, simply click the "File" menu, then click
on "Send".
 
Please use this screen's Context-Sensitive Help feature to find out more about what the
various settings and options do. If anything is not clear please let us know.
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Send an attachment
 
 
In the Email Editor, simply click on the "Insert" menu, then click on "Add Attachment".
 
Please use this screen's Context-Sensitive Help feature to find out more about what the
various settings and options do. If anything is not clear please let us know.
 
 



 

 

Insert a picture
 
 
There are two ways in which you can send pictures with emails. Either you can simply
send the picture file as an external attachment, or you can actually embed the picture in
the email body, as if it were part of the email itself.
 
To embed a picture into your email, simply click on the "Insert" menu, then click on
"Insert Picture".
 
Please use this screen's Context-Sensitive Help feature to find out more about what the
various settings and options do. If anything is not clear please let us know.
 
 



 

 

Send a newsletter
 
 
Usually when you send one email to more than one person, then each person who
receives the email can see all the email addresses of everyone else that you sent the
email to. Even if you use the "BCC" field, it is still quite easy for someone to look at the
underlying email properties and see who you sent it to.
 
What actually happens is this...
 
 

 
 
In other words we are sending one email to three people. They will all receive the same
email, and will all be able to see all the email addresses that you sent the email to.
 
Sometimes you may not want everyone to see all the addresses that you sent the email
to. For example, let's say that you were sending out an email newsletter to your clients.
You wouldn't want your clients to be able to see who else received the email!
 
Organize365 provides a feature called "Newsletter Mode" which solves this problem
for you. Newsletter Mode allows you to create one email message, and then send it to
multiple people, where each person receives a unique copy of the email, sent to only
their email address. In effect this is the same as if you physically sent a unique email to
each person. Or to use a picture, Newsletter Mode works like this..
 
 



 

 

 
 
In other words you are actually sending the email three times, not once. By using the
Newsletter Mode feature you can make Organize365 do this for you automatically! You
you only need to type and send one email, and Organize365 will then send separate
copies of that email to each person. This means that each person receiving the email will
only see their email address on the email, and they won't be able to see who else you
sent it to!
 
 
Email Personalization
 
What if you wanted to send one email to 10 different people, but you wanted each email
to start with the person's name? For example, "Dear George", "Dear Bob", etc.
 
With Organize365 this is easy to do! We have created a feature whereby you can
insert "fields" into the email, like [FIRSTNAME], [LASTNAME], etc. So by writing "Dear
[FIRSTNAME]" Organize365 will intelligently add each persons first name directly into the
email. So all your recipients will feel as though you took the time to write a unique email
just for them!
 
 
How do I do this?
 
To send an email in Newsletter Mode proceed as follows..
 

1. From the Email screen, click on the "New" button on the toolbar, as if you were
creating a regular email.

2. Enter the addresses of the people that you want to send the email to in the
"To" field. Separate the email addresses by using a semi-colon, for example
"gary@home.com; fred@work.com; mary@google.com".

3. Enter a subject line for your email.
 
So far we have not done anything differently to if we were sending a regular email.
 
Now you need to enable Newsletter Mode. Click on the "Tools" menu and click on "Enable
Newsletter Mode". Two things will happen. First, you will see the window's titlebar
changes from "Compose Email" to "Compose Newsletter". Second, you will see a new
menu appears called "Fields". You are now in Newsletter Mode!
 
You can now type your email message. If you want to personalize the email, you can do
this by using the "Fields" menu. For example...
 

1. In the email, type "Dear ".



 

 

2. From the "Fields" menu, click on "First Name". You will see that your email now
reads "Dear [%FIRSTNAME%]".

 
When you send the email Organize365 will substitute "[%FIRSTNAME%]" for each
recipient's first name! Easy as that...
 
 



 

 

Newsgroups
 
 



 

 

How do I...
 
 



 

 

Set up a newsgroup account
 
 
To subscribe to a newsgroup, proceed as follows...
 
Open the Email screen, click on the "Tools" menu, then click on "Newsgroup Accounts".
Click the "Insert" button to add a new Newsgroup Account.
 
 

 
 
The "New Account" dialog screen will appear. Enter all of the required fields. Use the
screen's Context-Sensitive Help feature if you need assistance with any of the fields.
 
Once you have created a new Newsgroup Account, you can then subscribe to its
various newsgroup items. Simply right-click on your Newsgroup Account, and choose
"Subscriptions" from the popup menu, as shown here...
 
 



 

 

 
 
That in turn opens the Newsgroup Subscriptions dialog, which will download and list the
available newsgroup items from the newsgroup server. Simply select the items that you
wish to subscribe to.
 
 

 
 



 

 

Once you have subscribed to one or more items, they will then appear in the tree, as
shown below. Simply right-click on any item and choose "Download Headers" to view its
messages.
 
 

 
 



 

 

Data Vault
 
 
The Organize365 Data Vault is a place where you can store any important information.
Examples of what you can store in the Vault could be passwords, directions, notes, bank
account details, etc. You can create categories for your data, so what you store in here is
up to you!
 
To open the Organize365 Data Vault, simply right-click on the Organize365 System Tray
Icon, and choose "Data Vault" from the menu that will appear. Below is a picture showing
the Data Vault, with the various parts of the screen outlined beneath it.
 
 

 
 
Menubar:
 
The "Menubar" contains your menus, which in turn provide you with numerous tools and
options.
 
Toolbar:
 
The toolbar provides "search" functionality, which you can use to search through all the
data stored in your Vault.
 
Format Bars:
 
The Format Bars provide typical formatting functionality for when you type data into the
Vault, such as "Bold", "Underline", "Font Color", etc.
 
Vault Text:
 



 

 

Once you have selected where you want to store the data in the Vault (using the Vault
Tree), you can type the text that you want to store here.
 
Vault Tree:
 
The Data Vault can consist of as many "pages" and "subpages" as you like. You can use
the Vault Tree to create new pages, arrange your pages into folders, and select which
page you want to view or edit.
 
 



 

 

Keyboard Shortcuts
 
 
This section has not yet been documented.
 
 



 

 

How do I...
 
 



 

 

Print data
 
 
You can easily print the data stored in your Vault. You can either print to a printer, or you
can preview the printout on your screen, or you can even create a PDF! To print the data
in your Vault, simply open your Organize365 Vault and choose "Print..." from your "File"
menu. The screen that will appear is outlined below...
 
Print Style:
 
Select whichever "Style" calendar you want to print.
 
Print Range:
 
You can currently only print all the data in your Vault. In future versions of Organize365
you will have more options in this droplist.
 
Target:
 
Here you can select from a number of "Targets", including the default printer, or PDF!
 
Other Options:
 
The options displayed here will vary depending on what you selected above in the
"Target" section. If you select to print to a printer, then you will be presented with:
 

• "Preview before printing" - This opens a "Print Preview" screen from where you
can either print the report, or you can cancel.

 
If you select "PDF" as the Target (see above), then you be presented with these options:
 

• "Open the file after we have generated it" - This will cause the PDF to open
(using Adobe Acrobat Reader if it is installed on your computer) after it has been
saved. Adobe Acrobat Reader is a free download (built by Adobe - not by us, we
take no responsibility or credit for how it works) and can be downloaded from
www.adobe.com.

• "Open the folder we are saving into once generated" - This will open the folder
into which the PDF was generated (using Windows Explorer).

• "Filename" - Organize365 will generate the report, and then save it to your hard
drive as a PDF document. Enter the file name for that PDF document here, or use
the lookup button to select a PDF file (which will be overwritten).

 

http://www.adobe.com/


 

 

Once you have selected the options that you want to use, simply press the "Print"
button, or the "Generate" button.
 
 



 

 

Desktop Notes
 
 
Organize365 has a feature called "Desktop Notes" that lets you create virtual "Sticky
Notes" on your computer's desktop. To create a new Desktop Note, simply right-click on
the Organize365 System Tray Icon, and choose "New Desktop Note" from the menu that
will appear. Below is a picture showing a Desktop Note, with the various parts outlined
beneath it.
 
 

 
 
Menu:
 
Click the little grey, downward-pointing arrow on the left of the Title Bar and a menu will
appear, presenting you with a number of options (including "Always on Top", "Send to
Another User", "Send to Calendar", and "Delete").
 
Titlebar:
 
You can move the Desktop Note by simply dragging its Title Bar with your mouse - in the
same way that you would move any normal window.
 
Close:
 
Click the Close button to close the Desktop Note. This does not delete the Note, it simply
closes it. The next time you start Organize365 the note will reappear. You can also
reopen any notes that you have closed by right-clicking on the System Tray Icon, and
selecting "Open Closed Notes" from the "Misc" submenu. If you want to delete a note
you can do that from the Menu (see above).
 
Note Text:
 
This is where you type whatever you want to store in your note.



 

 

 
Scrollbar:
 
If your Desktop Note is too small to display all the text you have entered into it, then
you can use the scrollbar to scroll up or down. You can also resize your Desktop Notes by
using your mouse.
 
Desktop Notes by default will appear on on your Desktop. If you open any other program
you will not be able to see your Desktop Notes. You can make a Desktop Note "float
on top" of any other programs so that it is always visible if you like - do this by ticking
"Always on Top" from the Menu (see picture above).
 
 



 

 

How do I...
 
 



 

 

Create a desktop note
 
 
Right-click on the Organize365 System Tray Icon, and click on 'New Desktop Note'. A
new Desktop Note will appear in the middle of your Windows' desktop.
 
 



 

 

Delete a desktop note
 
 
To delete a Desktop Note, simply click on the Desktop Note's Menu, and then choose
'Delete'. Click here if you need help locating the Desktop Note Menu.
 
NOTE: You can either 'Delete', or 'Close' a Desktop Note. Closing a Desktop Note is not
the same as deleting a Desktop Note. When you delete a Desktop Note it is deleted.
When you close a Desktop Note you can no longer see it on your desktop, but it is not
deleted. The next time you start Organize365 any notes that were previously closed will
reappear. You can also make closed notes reappear by right-clicking on the System Tray
Icon, selecting the 'Miscellaneous' menu, and then clicking on 'Open closed notes'.
 
For more information on how to close a Desktop Note, please click here.
 
 



 

 

Close a desktop note
 
 
To close a Desktop Note, simply click on the Desktop Note's Menu, and then choose
'Close'. Click here if you need help locating the Desktop Note Menu.
 
NOTE: Closing a Desktop Note is not the same as deleting a Desktop Note. When you
delete a Desktop Note it is deleted. When you close a Desktop Note you can no longer
see it on your desktop, but it is not deleted. The next time you start Organize365 any
notes that were previously closed will reappear. You can also make closed notes reappear
by right-clicking on the System Tray Icon, selecting the 'Miscellaneous' menu, and then
clicking on 'Open closed notes'.
 
For more information on how to delete a Desktop Note, please click here.
 
 



 

 

Enter text into a desktop note
 
 
Simply click on the Note Text Area of the Desktop Note window (click here if you need
do not know where that is), and then start typing. Use your Enter key to create new
paragraphs.
 
 



 

 

Instant Messaging
 
 
Organize365 has an Instant Messaging tool to send messages to other users who are
also using Organize365.
 
To start chatting with another Organize365 user, simply right-click on the Organize365
System Tray Icon, and choose choose "New Chat". You will then be presented with a list
of all the other users - simply tick which user you want to chat with, and click 'OK'.
 
 

 
 
1. Conversation Area:
 
The conversation area displays all the messages that you have sent to the person you
are chatting with, as well as all the messages that you have received.
 
2. Message Area:
 
When you want to send a message to the person you are chatting with, simply enter that
message here and then click the 'Send' button. Your message will then be sent and will
appear in the Conversation Area (see above).
 
3. Send Button:
 
See the section above titled 'Message Area'.
 
4. Status Bar:



 

 

 
The Status Bar displays useful information. It also displays two icons, one indicating
whether the conversation you are having is secure (meaning that no one else can 'listen
in' on your conversation), and the the other indicating whether you are currently chatting
across your LAN (local network) or the internet.
 
 



 

 

Keyboard Shortcuts
 
 
This section has not yet been documented.
 
 



 

 

How do I...
 
 



 

 

Chat with another user
 
 

• Right-click on the Organize365 System Tray Icon.
• Click on "New Chat".
• Tick the user that you want to chat with, and then click 'OK'.

 
A new Chat window will appear, from where you can chat with the user that you selected
(above). For more information on the Chat window and how it works, please click here.
 
 



 

 

Miscellaneous
 

 
 
 



 

 

Using the Report Previewer
 
 
Organize365 incorporates numerous reports. You can print your Address Book, your Data
Vault, and your Calendar, using a wide range of options.
 
If you choose to preview a report before printing it, then the Organize365 Report
Previewer will open. This screen can be used to preview your report, but it also includes
several useful additional features.
 
For example, from the "File" menu you can choose to either print the report that you are
currently previewing, or you can choose to save the report as a PDF file, or if you have
Microsoft Fax installed you can choose to fax the report!
 
Other buttons on the Report Previewer's toolbar enable you to zoom into and out of
the report, to navigate from one page of the report to another, and even to search the
report! Simply point your mouse at any toolbar item and a tooltip will appear, explaining
how the item works.
 
 



 

 

Sharing your data with other users
 
 
You can easily share your Organize365 data (calendars, addresses, etc) with other users
on your network!
 
Unlike other Personal Information Managers, Organize365 does not use a server. We
decided that we didn't like the idea of using a server because it means that someone
has to set up that server; you usually have to pay extra for the server's hardware and
software; if something goes wrong with the server it messes up everything for everyone;
and you can only see your data when you are connected to the server.
 
Instead, Organize365 has a built-in "Replication Engine". The way this works is really
simple, yet incredibly powerful. Let's say that Gary, Fred, and Bob are all connected to
the same office network, like this...
 
 

 
Let's say that Gary creates a new appointment in Organize365. As soon as he creates
the appointment, Organize365 intelligently scans the network for anybody else who is
using Organize365. If it finds other users it will automatically tell them about the new
appointment, and everyone will automatically see that appointment on their computers!
 
 

 



 

 

Okay, but what if Bob is away or not connected to the network when Gary creates his
new appointment? What then? How will Bob know about Gary's appointment?
 
Well, Gary's computer will still tell Fred's computer immediately, and it will tell Bob's
computer about the appointment the next time Bob is on the network!
 
Okay, but what if when Bob comes back Gary is no longer on the network?
 
Well, Gary's computer will tell Fred's computer about the appointment immediately,
so when Bob comes back Fred's computer will tell Bob's computer about Gary's
appointment!! How awesome is that!!? Another useful side-effect of this design is that
when Bob is away from the network he still has full access to all of his data! So you
can easily run Organize365 on a laptop and take the laptop off-site; every time you
reconnect to the network Organize365 will automatically tell everyone else what changes
you made to your data, and it will update itself with any changes that other users made
while you were away!!
 
You might need to get a cup of coffee before looking at the next picture because this is
just so fantastic... In effect, here's what Organize365 does over your network to ensure
that all data is replicated to everyone as quickly as possible, and to ensure that all data
gets to everyone even if they are away...
 
 

 
This means that if a new user joins the network (well call her "Anne"), then any of the
computers can tell her about everyone's data, like this...
 
 



 

 

 
Impressed? Good.
 
Okay. Now that we've explained how it works, below are some common questions we get
asked...
 
 
I want to share my Address Book and / or my Calendar. Where do I begin?
 
In the 'Program Options' window, select the 'Data-Sharing' tab. Simply tick "Enable
Organize365 data-sharing" and you're done!
 
 
Can I set which users on my network are allowed to see my appointments?
 
Because we understand that people's information is private, we have designed
Organize365 not to share information unless you want it to. By default Organize365
will not share any of your data (Address Book or Calendar). If you want to share your
data you need to open the Program Options screen, select the 'Data-Sharing' tab, and
manually tick 'Enable Organize365 data-sharing'.
 
You have further control when sharing your calendar in that you can also set 'User
Permissions', so that certain users can have read-only access, full access, or no access.
To configure which users you want to share your data with, simply open the Program
Options screen, select the 'Data-Sharing' tab, then click on the button titled "Configure
Other Users".
 
 
What if I only want to share some of my addresses with other users?
 
Each address in your Address Book has a checkbox called "Private". By default this is not
ticked, meaning that all the addresses in your Address Book are not private, and if you
enable data-sharing all your addresses will be shared. If you do not want to share certain
addresses in your Address Book, simply tick the "private" checkbox for those addresses.
Easy as that! There is a similar "private" checkbox for your tasks and your appointments.



 

 

 
If you mark an Address as Private and that address has already been shared with
other users, any changes you make to that address from that time onward will not be
shared. If you mark an Appointment or a Task as Private after you have already shared
it with other users it will be removed from their calendars. If you create a new Contact,
Appointment, or Task, and mark it as Private immediately, it will not be shared with other
users.
 
 
If I share my data with other users on my network, what happens when I try to
use Organize365 if I am not connected to the network?
 
That's the beauty of this design. Your data is still stored on your computer, so if you
are not connected to the network you can still see and change all of your data, even if
you're not connected to the network! Simply continue working, and the next time you
are connected to the network your changes will be sent to the other users and you will
receive any changes they made since you unplugged.
 
 



 

 

Logging in / out
 
 
Because you will be storing personal information in Organize365, we have provided a
number of mechanisms to protect your confidential information. In some parts of the
program we encrypt your data, in some places we encrypt the communication between
multiple copies of Organize365 on a network, or communication over the internet.
Another mechanism that we have built into Organize365 is the ability to Log Out of
Organize365.
 
To Log Out of Organize365, simply right-click on the Organize365 System Tray Icon, and
choose "Log Out". You will then be "Logged Out". You will then need to "Log In" before
you can use Organize365 again. To Log In, you simply right-click on the Organize365
System Tray Icon, and choose "Log In". Easy as that. You can also set a password, so
that when you Log Out you will be asked to enter your password before you can Log In
again. To set a password, simply open the Program Options screen, select "General" from
the "Options List", and then enter a password in the field titled "Login Password".
 
 



 

 

Program Options
 
 
As with any software, Organize365 can be configured using a "Program Options" screen.
This screen can be accessed by right-clicking on the System Tray Icon, and selecting
"Options".
 
The Program Options screen is broken up into categories. On the left of the screen you
will see a list of these categories, such as "General" (for general options), "Interface" (for
options pertaining to the user interface), and so forth. Simply select an item from this
list (either by using your mouse, or by using CTRL+TAB on your keyboard) and settings
pertaining to that category will appear on the right hand side of the Program Options
window.
 
The Program Options screen has Context-Sensitive Help which you can use to find out
more information about any setting. If you need more information, it can be found by
selecting the applicable page from the list below:
 
 



 

 

General
 
 
The 'General Options' screen lets you set up general program options.
 
Please use this screen's Context-Sensitive Help feature to find out more about what the
various settings and options do. If anything is not clear please let us know.
 
 



 

 

Interface
 
 
The 'Interface Options' screen lets you configure how Organize365 looks. It also lets you
set how dates and times should appear (for example day/month/year or month/day/
year), and disable the splash screen and so on.
 
Please use this screen's Context-Sensitive Help feature to find out more about what the
various settings and options do. If anything is not clear please let us know.
 
 



 

 

Projects
 
 
This section has not yet been documented.
 
 



 

 

Email
 
 
The 'Email Options' screen lets you configure your Organize365 email settings. Please
use this screen's Context-Sensitive Help for more information, or see the section titled
"How do I set up an email account" in the FAQs.
 
 



 

 

Calendar
 
 
Organize365 has several different sections in the 'Program Options' screen for setting
how the Calendar works. The 'main' or 'General' Calendar Settings section lets you
set options such as what day of the week you regard as being the 'first day', how long
default reminders should be and so on.
 
Please use this screen's Context-Sensitive Help feature to find out more about what the
various settings and options do. If anything is not clear please let us know.
 
 



 

 

Calendar Labels
 
 
Organize365 has several different sections in the 'Program Options' screen for setting
how the Calendar works. The 'Calendar Labels Options' section is used for assigning
names to Calendar Labels. Calendar Labels can be used to categorize your appointments
and tasks. Appointments and tasks that are assigned a label will appear in a specific
color, so that you can easily identify them as belonging to a certain category.
 
Please use this screen's Context-Sensitive Help feature to find out more about what the
various settings and options do. If anything is not clear please let us know.
 
 



 

 

Calendar Reminders
 
 
Organize365 has several different sections in the 'Program Options' screen for setting
how the Calendar works. The 'Calendar Reminder Options' section is used for setting how
reminders work.
 
Please use this screen's Context-Sensitive Help feature to find out more about what the
various settings and options do. If anything is not clear please let us know.
 
 



 

 

My Pictures
 
 
Please click here for an overview of the 'My Pictures' functionality.
 
This part of the Program Options allows you to adjust various settings that pertain to the
'My Pictures' functionality. Please use this screen's Context-Sensitive Help feature to find
out more about what the various settings and options do. If anything is not clear please
let us know.
 
 



 

 

Data Sharing
 
 
If you have not already done so, please read the section in the documentation titled
sharing your data with other users. This will give you an overview what the settings on
this window mean.
 
Please use this screen's Context-Sensitive Help feature to find out more about what the
various settings and options do. If anything is not clear please let us know.
 
 



 

 

Notification
 
 
The 'Notification Options' screen lets you configure how Organize365 notifies you when
something occurs that needs your attention.
 
Please use this screen's Context-Sensitive Help feature to find out more about what the
various settings and options do. If anything is not clear please let us know.
 
 



 

 

Backup
 
 
The 'Backup Options' screen lets you configure how Organize365 backs up your data.
 
Please use this screen's Context-Sensitive Help feature to find out more about what the
various settings and options do. If anything is not clear please let us know.
 
 



 

 

Hotkeys
 
 
This section has not yet been documented.
 
 



 

 

Program Logs
 
 
The 'Program Logs' screen displays the Organize365 system log, which can be used
to identify potential problems and can be helpful in the event that you contact us for
technical support.
 
Please use this screen's Context-Sensitive Help feature to find out more about what the
various settings and options do. If anything is not clear please let us know.
 
 



 

 

System Info
 
 
The 'System Info' screen displays useful information about your computer, and your
Organize365 installation. The primary purpose for this screen is so that in the even that
you contact us for support and we need to know information about your system, you can
simply refer to this screen.
 
 



 

 

FAQs
 

 
 
 



 

 

The System Tray Icon
 
 
Question
 
Where do I find the System Tray Icon?
 
 
Answer:
 

 
The section on your Windows Taskbar which contains your clock is officially called the
'Taskbar Notification Area', but it is more commonly called the 'System Tray'. In the
System Tray you will find your Windows clock, as well as a number of icons. When you
install Organize365 you will see a new icon appears in the system tray (shown below). If
you right-click on this new icon the Organize365 tray menu will appear, from where you
can open the various tools that make up Organize365, such as your Calendar, and your
Address Book.
 
 



 

 

Context-sensitive help
 
 
Question
 
What is Context-Sensitive Help?
 
 
Answer:
 
Along with this manual, Organize365 provides additional help by means on "Context-
Sensitive Help". On most of the Organize365 screens you will see a question mark in
your titlebar. If you click on this question mark, you will notice that your mouse cursor
changes from an arrow to a arrow accompanied by a question mark.
 
When your mouse cursor looks like that (above), you can then select any item on the
window to find out more about that item. Simply click the "Question Mark" on the
titlebar, then select an item on the window to find out more about that item. Easy as
that. Generally the documentation (what you're reading now) explains broader concepts
about a window or a feature, and the Context-Sensitive Help will explain more specific
information about what a particular control or part of a window does.
 
If you simply point your mouse at a control and leave it there for several seconds, the
same information that you would see in the Context-Sensitive Help will appear as a
"tooltip". Tooltips are different from Context-Sensitive Help as they disappear as soon as
you move your mouse. To close a Context-Sensitive Help window, simply click on it.
 
 



 

 

Registration code failing
 
 
Question
 
The registration code that I was given to register Organize365 does not work!
 
 
Answer:
 
There are several possible reasons why a registration code will fail when you try to
register Organize365. Please read through the following list, and if you still cannot
establish what the problem is please contact us.
 
1. You have not entered the code correctly
 
Please ensure that you enter the code (and the other information) exactly as it was
provided to you. It must be the same case, must use the same characters, the same
spacing, etc.
 
2. The registration code has expired
 
Registration codes must be entered into Organize365 within 7 days of being issued,
or the codes will expire. If you need to register or re-register Organize365 and the
registration code that you have was issued more than 7 days ago, please contact us for a
new registration code.
 
 



 

 

Addendums
 

 
 
 



 

 

Using Organize365 in other languages
 
 
You can easily use Organize365 in languages other than English. Simply open the
"Program Options" window, select the "Interface" section, and select the language you
would like to use from the "Language" droplist.
 
Each language is stored in a separate file on your computer, in your
"Organize365\Language" subfolder. Inside that subfolder you should find files such
as "German.LNG", "Spanish.LNG", and so forth. If the language you are wanting to
use is not in that folder, and if you would like to help us translate Organize365 into
that language, please email us and we will email you the list of words that need to
be translated from English. If you translate them (or some of them) and email us the
translated words, we will then create a LNG file in your language, and will include it in
the next version of Organize365. This is how all the language files so far were created.
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